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Chapter 373

Mixed Models Tests for
the Slope Difference in
a 3-Level Hierarchical
Design with Random
Slopes (Level-2
Randomization)
Introduction
This procedure calculates power and sample size for a three-level hierarchical mixed model which is randomized
at the second level. The goal of the study is to compare two group slopes. If the group means are identical at the
beginning of the study (which they often are in a randomized trial), testing the difference in slopes is the same as
testing the difference in means and the final time point. This is a test of the time-by-treatment interaction.
The study is assumed to be longitudinal in that the third level is some type of cluster (e.g., clinic or hospital), the
second level is subjects nested within the third level, and the first level is a repeated measurement at equallyspaced time points on the subjects. Ahn, Heo, and Zhang (2015) call this a longitudinal cluster randomized
design.
The data are analyzed by considering the average trend of responses over time. These trends can be considered as
random (this procedure) or fixed (a companion procedure).

Randomization
Different models are used depending on how subjects are assigned to the intervention (treatment) groups. This
procedure assumes that each subject (level-2 unit) is individually randomized to an intervention group. This is
called level-2 randomization. A companion procedure analyzes the case of level-3 randomization.

Fixed or Random
The subject-specific slopes of responses across the repeated measurements can be assumed to be fixed or random.
In this random case, each subject is assumed to have its own slope. These slopes are assumed for follow a normal
distribution.
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Technical Details
Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.4.2, page 206-208. The
hierarchical mixed model used for the analysis is
𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 = 𝛽𝛽0 + 𝜉𝜉𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖 + 𝜏𝜏𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 + 𝛿𝛿𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖 𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑢𝑢𝑖𝑖 + 𝑢𝑢𝑗𝑗(𝑖𝑖) + 𝑣𝑣𝑗𝑗(𝑖𝑖) 𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖

where
𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖

is the continuous response of the kth level-1 unit of the jth level-2 unit of the ith level-3 unit.

𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖

is an integer that represents the time period. We assume that 𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 = 𝑇𝑇𝑘𝑘 and that these time values
increase from 0 (baseline measurement) to M – 1 (final measurement).

𝜉𝜉

is the intervention effect at baseline.

𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖
𝛽𝛽0

𝜏𝜏

𝛿𝛿

𝑢𝑢𝑖𝑖

is an indicator variable that is 1 if ijkth unit is in group 1 and 0 if it is in group 2.

is the overall fixed intercept.

is the slope of the time effect.
is the treatment effect of interest. It models the difference between the two group slopes.
is the level-3 random intercept effect for the ith level-3 unit. It is distributed as 𝑁𝑁(0, 𝜎𝜎32 ).

𝑢𝑢𝑗𝑗(𝑖𝑖)

is the level-2 random intercept effect for the j(i)th level-2 unit. It is distributed as 𝑁𝑁(0, 𝜎𝜎22 ).

𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖

is a random error term which is distributed as 𝑁𝑁(0, 𝜎𝜎𝑒𝑒2 ).

𝑣𝑣𝑗𝑗(𝑖𝑖)

are the subject-specific random slopes. Their distribution is 𝑁𝑁(0, 𝜎𝜎𝜏𝜏2 ).

𝜎𝜎 2

is the variance of Yijk, where 𝜎𝜎 2 = 𝜎𝜎𝑒𝑒2 + 𝜎𝜎22 + 𝜎𝜎32 .

𝑟𝑟𝜏𝜏

is ratio of two variances: 𝑟𝑟𝜏𝜏 = 𝜎𝜎𝜏𝜏2 /𝜎𝜎 2.

𝜌𝜌

is the correlation among level-1 units which are in a particular level-2 unit. For fixed models like
this, 𝜌𝜌 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶�𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 , 𝑌𝑌𝑖𝑖𝑗𝑗𝑗𝑗 ′ � = (𝜎𝜎22 + 𝜎𝜎32 )/𝜎𝜎 2 .

C

is the number of level-2 units (subjects) per level-3 unit.

K1

is the number of level-2 units (clusters) assigned to group 1.

K2

is the number of level-2 units assigned to group 2.

M

is the number of level-1 units per level-2 unit, i.e., the number of repeated measurements.

The test of significance of the Xijk Tijk interaction term in the mixed model is the test statistic of interest. It tests the
difference of the two slopes.
The power can be calculated using
⎧
⎫
⎪ 𝛿𝛿
⎪
𝐶𝐶𝐾𝐾2 𝑀𝑀Var(𝑇𝑇)
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = Φ � � �
− Φ(1 − 𝛼𝛼/2)
⎨ 𝜎𝜎 �(𝑓𝑓3 + 𝑟𝑟𝜏𝜏 𝑀𝑀Var(𝑇𝑇))(1 + 1)�
⎬
⎪
⎪
𝜆𝜆
⎩
⎭
where 𝜆𝜆 = 𝐾𝐾1 /𝐾𝐾2 , 𝑓𝑓3 = 1 − 𝜌𝜌, and Var(𝑇𝑇) = (𝑀𝑀 − 1)(𝑀𝑀 + 1)/12.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are δ, Power, C, and K1.
Under most situations, you will select either Power to calculate power or K1 to calculate the number of level-2
units. Occasionally, you may want to fix K1 and K2 and calculate C.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found. This search considers only integer
values of C or K1.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard.
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha
that represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size
C (Level 3 Units)
This is the number of level 3 units in group 1 (treatment group). The sample size for this group is equal to
Ceiling(C1 * K * M).
Examples of level 3 units are clinics, hospitals, or practices.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated
measurements are the level 1 units.
This value must be a positive integer.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.
K1 (Level 2 Units Assigned to Group 1)
Enter the average number of level 2 units per level 3 unit that are assigned to group 1 (treatment group). The
sample size for this group is equal to Ceiling(C * K1 * M).
Examples of level 2 units are subjects and patients. A longitudinal study might include clinics as the level 3 units,
patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive number. Decimal values such as 4.5 can be entered.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.
K2 (Level 2 Units Assigned to Group 2)
This is the number of level 2 units per level 3 in group 2 (control group). The sample size for this group is equal
to Ceiling(C * K2 * M).
Examples of l2 units are classrooms or patients. A longitudinal study might include clinics as the level 3 units,
patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive number. Decimal values such as 5.7 can be entered.
Using Multiples of K1
If you simply want a multiple of the value for group 1 (K1), you would enter the multiple followed by "K1", with
no blanks. If you want to use K1 directly, you do not have to enter the leading "1". For example, all of the
following are valid entries: K1, 2K1, 0.5K1, and 1.5K1.
You can use a list of values such as "10 20 30" or "K1 2K1 3K1".
M (Level 1 Units Per Level 2 Unit)
This is the average number of level 1 units in each level 2 unit. Examples of level 1 units are repeated
measurements.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated
measurements are the level 1 units.
This value must be a positive integer that is at least 2.
You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.
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Effect Size
Slope Input Type
Select the input type for entering the difference in slopes. Two options are available: (μ1 - μ2) and δ.
•

μ1 - μ2 (Mean Difference)
Enter the difference in means at the final time point. The difference in slopes will then be calculated from this
value. This option is provided because this is a value that can be easily interpreted and should be readily
available.

•

δ (Slope Difference)
Enter values for δ directly. This option requires you to determine appropriate values for δ which will often be
difficult.

μ1 - μ2 (Mean Difference)
Enter one or more values for the mean difference where μ1 is the mean of group 1 at the final measurement and
μ2 is the mean of group 2 at the final measurement. This mean difference is used to calculate the difference in
slopes (δ) using the formula:
δ = (μ1 - μ2) / (M - 1).
This formula comes from the group-by-time interaction term in the mixed model which is δXT. Here, X indicates
whether the subject is a member of group 1 or not, and T is the time. Since this procedure assumes that the times
are 0, 1, 2, ..., (M-1), the value of T at the last measurement point is (M-1). Thus, δXT = δX(M-1) at the last time
point. This leads to the above formula.
The subject slopes are assumed to be random from a normal distribution with different group means.
The power is the probability of detecting a δ of at least this amount. This value is not necessarily the true
difference. Rather, it is the difference you want to detect.
The difference, μ1 - μ2, can be any non-zero value (positive or negative). Since this procedure uses a is a twosided test statistic, you will get the same result with either positive or negative values.
The difference has the same scale as the standard deviation.
Syntax
You can enter a single value such as 1 or a series of values such as 1 2 3 or 1 to 2 by 0.2.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
δ (Slope Difference)
Enter one or more values for δ which is the difference between the group 1 and 2 slopes of the outcome over time.
This difference equates to the difference in means at the final measurement if the means at the first measurement
are equal (which is often the case for randomized trials).
The formula of the relationship between the group means at the final measurement is (μ1 - μ2) = δ (M - 1).
The slopes of the measurements across time are assumed to be a random. These slopes are distributed normally
with different mean slopes for the two groups. The power is the probability of detecting a difference of at least
this amount between the two average slopes. This value is not necessarily the true difference. Rather, it is the
difference you want to detect.
Range: δ can be any non-zero value (positive or negative). Since this procedure uses a is a two-sided test statistic,
you will get the same result with either positive or negative values.
You can enter a single value such as 1 or a series of values such as 1 2 3 or 1 to 2 by 0.2. When a series of values
is entered, PASS will generate a separate calculation result for each value of the series.
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σ (Standard Deviation)
Enter the standard deviation of an individual observation, Yijk. This standard deviation applies for both groups. A
good estimate of this value is the average squared residual from a previous study.
Note that σ must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7
9 or 1 to 9 by 2.
Press the small ‘σ’ button to the right to obtain calculation options for estimating the standard deviation.
ρ (Within Subject Correlation)
This is the correlation of each pair of repeated measurements within a subject.
Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.5.
You may enter a single value or a list of values.
rT (Random Slope Variance/σ²)
Enter the ratio of the variance of subject-specific, random slopes to the sum of the other variances, σ².
Possible values range from 0 (for a fixed-slope model) to any positive value.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 1 by 0.1.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
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Example 1 – Calculating Power
Suppose that a three-level hierarchical design is planned in which repeated measurements (level-1) will be taken
on subjects (level-2) within hospitals (level-3). This analysis will calculate the power for detecting the difference
in slopes of two interventions. Randomization will be at the subject (level-2) units. The following parameter
settings are used for the power analysis: μ1 - μ2 = 2; σ = 2.6; ρ = 0.1; rT = 0.1; K1 = 5, 10, 15, 20; M = 5; α =
0.05; and C = 4, 6.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Random Slopes
(Level-2 Rand.) procedure window.
You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... Power
Alpha .............................................................. 0.05
C (Level 3 Units) ............................................ 4 6
K1 (Level 2 Units Assigned to Group 1) ........ 5 10 15 20
K2 (Level 2 Units Assigned to Group 2) ........ K1
M (Level 1 Units Per Level 2 Unit) ................. 5
Slope Input Type............................................ μ1 - μ2 (Mean Difference)
μ1 - μ2 (Mean Difference).............................. 2
σ (Standard Deviation) .................................. 2.6
ρ (Within Subject Correlation)........................ 0.1
rT (Random Slope Variance / σ²) .................. 0.1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Three-Level Hierarchical Mixed Model

Power
0.2861
0.5052
0.6760
0.7968
0.4008
0.6760
0.8412
0.9275

Total
N
200
400
600
800
300
600
900
1200

Level 3
Units
C
4
4
4
4
6
6
6
6

Group 1
Level 2
Units
K1
5
10
15
20
5
10
15
20

Group 2
Level 2
Units
K2
5
10
15
20
5
10
15
20

Level 1
Units
M
5
5
5
5
5
5
5
5

Mean
Diff
μ1 - μ2
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00

Std
Dev
σ
2.60
2.60
2.60
2.60
2.60
2.60
2.60
2.60

Level 1
Corr
ρ
0.100
0.100
0.100
0.100
0.100
0.100
0.100
0.100

V(βi)
/σ²
rT
0.100
0.100
0.100
0.100
0.100
0.100
0.100
0.100

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

References
Ahn, C., Heo, M., and Zhang, S. 2015. Sample Size Calculations for Clustered and Longitudinal Outcomes in
Clinical Research. CRC Press. New York.
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units.
C is the number of level-3 units.
K1, K2 are the average number of level-2 units per level-3 unit assigned to groups 1 and 2, respectively.
M is the number of level-1 units (repeated measurements) per level-2 unit (subject).
μ1 - μ2 is the difference in the two group means at the final measurement time: M - 1. δ = (μ1 - μ2) / (M - 1).
σ is the standard deviation of the level-1 responses.
ρ is the correlation among level-1 units in a particular level-2 unit.
rT is ratio of the subject-specific slope variance to σ².
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.
Summary Statements
The total sample size of 200, which were obtained from 4 level-3 units with 5 level-2 units in
group one and 5 level-2 units in group two and 5 level-1 units (repeated measurements) per
level-2 unit, achieves 29% power to detect a difference between the (random) group means at the
last time of 2.00. The standard deviation of level-1 units is 2.60. The correlation of level-1
units within a level-2 unit is 0.100. The ratio of the subject-specific slope variance to σ² is
0.100. A test based on a mixed-model analysis is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power versus K1 for the two values of C.
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Example 2 – Calculating Sample Size (Number of Subjects)
Continuing with the last example, suppose the researchers want to determine the number of subjects needed to
achieve 90% power for the values of C.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Random Slopes
(Level-2 Rand.) procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... K1 (Number Level 2 Units Per Level 3 Unit)
Power ............................................................. 0.90
Alpha .............................................................. 0.05
C (Level 3 Units) ............................................ 4 6
K2 (Level 2 Units Assigned to Group 2) ........ K1
M (Level 1 Units Per Level 2 Unit) ................. 5
Slope Input Type............................................ μ1 - μ2 (Mean Difference)
μ1 - μ2 (Mean Difference).............................. 2
σ (Standard Deviation) .................................. 2.6
ρ (Within Subject Correlation)........................ 0.1
rT (Random Slope Variance / σ²) .................. 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Three-Level Hierarchical Mixed Model

Power
0.9001
0.9001

Total
N
1080
1080

Level 3
Units
C
4
6

Group 1
Level 2
Units
K1
27
18

Group 2
Level 2
Units
K2
27
18

Level 1
Units
M
5
5

Mean
Diff
μ1 - μ2
0.50
0.50

Std
Dev
σ
2.60
2.60

Level 1
Corr
ρ
0.100
0.100

V(βi)
/σ²
rT
0.100
0.100

Alpha
0.050
0.050

This report shows the power for each of the scenarios.
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Example 3 – Validation using Ahn, Heo, and Zhang (2015)
Ahn, Heo, and Zhang (2015) page 207 provide a table in which several scenarios are reported. We will validate
this procedure by the first row of the table. Actually, the table is for level-3 randomization. Following their
instructions, we switch K and C to obtain results for level-2 randomization.
The following parameter settings were for the analysis: power = 0.80; δ = 0.3; σ = 4; ρ = 0.1; C = 8; M = 5; and α
= 0.05. These settings resulted in a value of K1 (their N3(0)) of 67 and an attained power of 0.804.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Random Slopes
(Level-2 Rand.) procedure window. You may then make the appropriate entries as listed below, or open
Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... K1 (Number Level 2 Units Per Level 3 Unit)
Power ............................................................. 0.8
Alpha .............................................................. 0.05
C (Level 3 Units) ............................................ 8
K2 (Level 2 Units Assigned to Group 2) ........ K1
M (Level 1 Units Per Level 2 Unit) ................. 5
Slope Input Type............................................ δ (Slope Difference)
δ (Slope Difference) ....................................... 0.3
σ (Standard Deviation) .................................. 4
ρ (Within Subject Correlation)........................ 0.1
rT (Random Slope Variance / σ²) .................. 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Two-Level Hierarchical Mixed Model

Power
0.8042

Total
N
5360

Level 3
Units
C
8

Group 1
Level 2
Units
K1
67

Group 2
Level 2
Units
K2
67

Level 1
Units
M
5

Slope
Diff
δ
0.30

Std
Dev
σ
4.00

Level 1
Corr
ρ
0.100

V(βi)
/σ²
rT
0.100

Alpha
0.050

PASS calculates the same values of K1 and power: 67 and 0.8042.
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